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Summary Upgrade Instructions for Integra for Notes 4.7

This document is designed to assist users currently utilizing older versions of Integra for Notes to upgrade their systems to
Integra for Notes 4.7. A summary of the main new features available in Integra for Notes 4.7 are available at
www.integra4notes.com/whatsnewin/47.

Following these instructions correctly will ensure a smooth transition from one version of Integra for Notes to the next. The
step-by-step upgrade process is summarized below and then further defined in detail within the subsequent sections of this
document.

If you are upgrading from a version of Integra 4.2 or older, you will require a new license key.

d Please read and follow the special instructions for users of Integra 4.7 or older found in the next
section.

The Upgrade Process

In summary the process of updating your Integra for Notes environment involves the following steps which are described in
greater detail in the sections below:

10.

11.
12.

Request an upgrade to Integra for Notes 4.7 from www.integra4notes.com/upgrade.

Download the Integra.exe installer file which contains the Integra.ntf template file and store this in a folder on
your PC.

Users of Integra 4.2 or older should wait until they receive the new Integra for Notes 4.7 license key. Upgrading
their Integra environment to 4.7 without deploying the new key will result in a failure of the system to operate.

Take a backup copy of your existing Integra database(s) and of your current Integra template (Integra.ntf).

After obtaining the new license key (only required by users Integra 4.2 or older), run the Integra.exe file from the
previously chosen folder. This will allow extraction of the new Integra.ntf template to the default Notes data
directory of your local workstation.

Sign the template with an ID file authorized to run on the server on which Integra will be deployed and which will
avoid ECL warnings for your users at runtime.

Modify the Inherit from Design Template property of your existing Integra database(s) to read IntegradNotesR47
and refresh the Design of your Integra database from the locally stored template

Replace the current license key found in the License tab found in the Configuration page with the new Integra 4.7
license key.

Run the Upgrade Documents & Profiles agent. This is very important.

If you are using scheduling on a Windows based Domino server, re-enable scheduled running through the
Configuration document using a Notes ID authorized to run restricted agents.

Enable the Integra database for web browser access (optional)
Enable Integra PDF Writer (optional)

The subsequent sections of this document address each of these steps in detail.



http://www.integra4notes.com/upgrade�

integra

for notes

1 Obtain the latest Integra template

Integra.exe, containing the Integra.NTF e
template and documentation are P ¢ X & (i comnope

Integra Updste Page

@integra

available to all clients with an up to date
maintenance agreement. To access this
template, point your web browser to
www.integradnotes.com/upgrade and
you will then be presented with a screen
similar to that shown alongside:

You will be required to provide certain
the details in this form consisting of:

Name of Organization — this is the
name of your organization and is
used just for logging purposes. Itis
not the Notes organization name or -
domain name but just the standard B
name.

Please enter the following details to download an Integra Update | cup.

e

Urnbess youre seeking @ particalar relesse, pleass abways downioad the Latest relesse (shown
by dataut] Yoo 230 Upgrads Fom amy prevous rHASEE b the Latast raleazs dectly

Name of Crganizatien
Corenet Hama

el Address

Product intergra b Motes, Qi Repors. Designes. Runtme = .

Viersin 1o Doweload 4507 =
Cusrent License Key
Please paste the FULL ey, for imstance.
[ADE3  F2A) ACME. DE 1001

Dormain Detads &

e th et Sarwe/Ooganiscation (o Dormamn)

This download request page is only avadable to holders of a full Integra ficence key. ¥ youre
eegra and you would ke 10 request the latest relese, please refer 1o our evslustion
e pigs. Yiou will need

[P

[E T pe——

U L

Contact Name — this is the name of
the person responsible for downloading the upgrade.

e-mail address — the e-mail address of the person responsible for downloading the upgrade and who is to

receive the e-mail containing the login details.

Version to Download — this allows you to define the version number that you would like to download. While
typically you would choose the default option which would be the current shipping version, if you specifically
wish to download an older version, this option will allow that flexibility.

Current License Key — this field requires you to enter the license key of your current version of Integra. This
can be found from the Configuration document where the key is shown in the License tab.

Domain Details — this field contains the Notes name of the certificate used by your server and users within
your organization. This field is automatically updated based on the key entered in the Current License Key
field above as soon as you tab out of the Current License Key field.

Following entry of this requested information click on the request Download button.

[ Request Download

After filling in the Request Form and submitting it, the user will receive an automated email containing a link to a
temporary page to allow the manual downloading of the same Integra.exe installer. The temporary page is
available only for a limited time period and the URL provided should be used as soon as possible to download

even if the upgrade will occur later.

login details.

If after receiving the e-mail containing your login details you do not download within
48 hours, you may find that the login is no longer available. This would require you to
register once more for the upgrade, a process which will send another e-mail with new

Integra for Notes 4.7 — Upgrade Manual Version 1.01
Shireburn Software Ltd © 2008/9 — 16" January 2009
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1.1 Select New Licensing Method — only required by users of Integra 4.2 or older
If you are upgrading from Integra 4.2 or older, since new licensing options have been available since Integra 4.3,
you will require a new license key.
Since Integra for Notes version 4.3, Integra software products have been licensed on a per user basis instead of the
per server basis previously available and is now available in two versions:
Integra for Notes Designer Edition - allows a user equipped with this license to create and edit Integra for
Notes profiles.
Integra for Notes End-User edition - allows a user equipped with this license to run Integra profiles but not
modify the design of these profiles.
Unlike previous versions of Integra which were licensed per server, these licenses run across an unlimited number
of servers within the same Lotus Notes Domain. This new method brings a number of benefits to Integra, it's
partner network, new potential customers and the existing client base, namely:
we will be able to offer a lower entry point for Integra for Notes
we will be more competitive for customers who have a large number of servers but not necessarily a large
number of users
launching Integra reports will no longer be limited by the server, but will be available throughout the entire
Notes domain
the model will enable easier deployment on clustered servers, development and test environments
no longer separate (higher) pricing for iSeries and Sun Solaris deployments
Existing licensees of Integra for Notes who have purchased Integra under the server based licensing model and are
now upgrading to Integra for Notes 4.7 are therefore able to:
switch their licensing method to a user-based method.
OR
retain that method of license moving forward onto Integra for Notes 4.7
Clients opting to switch their current server-based Integra for Notes license to an end-user based license can
convert each server license to one of the following:
Option 1
100 x Integra for Notes End-user Edition
1 x Integra for Notes Designer Edition
Option 2
50 x Integra for Notes End-user Edition
3 x Integra for Notes Designer Edition
Clients will need to make their choice on requesting an upgrade to Integra for Notes 4.6 when going to
www.integra4notes.com/upgrade. For more details about the new licensing model please refer to
www.integra4notes.com/licensing/43.
Integra for Notes 4.7 — Upgrade Manual Version 1.01 2
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When upgrading to Integra for Notes 4.7 you will require a new license key. Following
ﬁ your request for an upgrade you will also receive a separate e-mail with your new key.

It is important to wait for the new license key to be received prior to actually
undertaking subsequent steps to refresh the design of your existing database as you
will otherwise be locked out of the Integra application.

The Integra upgrade site will recognize that your site is using Integra 4.2 or older and, in this case you will be
presented with a number of additional options in the upgrade form to allow selection of the choice of licensing
method to be implemented for your site. These are shown in the screenshot below:

Once a choice of licensing method has been selected, this is irreversible. To ensure
you are able to make an informed decision please refer to the description of the new
licensing found at www.integra4notes.com/licensing/43.

Integra Update Page =

« C T hitp//www.integradnotes.com t/Inte ’ 1 0pe : » [O- F-
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. Ltk My

Please enter the following details to download an Integra Update

This dewnlcad request page is only avalable to holders of a hull Integra icence key. Il you'e
evaluating Integea and you would like to request the [atest releass, plaase refor 1o our evaluation
downlead page. which is raschable from our hema page. You will need to register once again
with your full delards

Unlets you're seaking a pamicular reléase. please always download the latest release (shawn
by defsult) You can upgrade from any previous releass to the Istest release directly
cUICK LNKE
£l .
B3 o Narme of Organisation | Acme Gomp

.
Contact Name Jabn Dow 5
.
o-Madl Address john dos@acme cam L
Product Integra for Notes. Quick Reporis, Designer, End User =] &y

Version to Download | 47,00 [=]

Curent Licents Koy | [BE4AIATEEER2MOCCSITIAGFATEMEFA) YACME, AD20000 * ras
Flease paste the FULL key, for instance: (ADEJ. FZA]VACME. DE1001

Domain Details 2 | /Acme
in the format tter.er-'urgam atson (or Domain).

Help B fields are mandatory

Having made your licensing choice you should receive a new license key by e-mail which needs to be updated into
Integra for Notes at the appropriate point in the cycle (see section 8).

It is important to wait for the new license key to be received prior to actually undertaking subsequent steps to
refresh the design of your existing database as you will otherwise be locked out of the Integra application. In the
event that you do not receive this e-mail within 24 hours, please contact support@integra4notes.com.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 3
Shireburn Software Ltd © 2008/9 — 16" January 2009



http://www.integra4notes.com/licensing/43�
mailto:support@integra4notes.com�

integra

for notes

2 Take a backup

Good practice dictates that you should take a backup of your current Integra for Notes database as well as the
current Integra.NTF template to allow you to recover from any failed upgrade and to roll back to your previous
version.

The taking of a backup is strongly recommended by Shireburn Software

i Ltd.

Since the file name of the template for Integra 4.6 is Integra.ntf as was the
case with earlier versions of Integra, please ensure that you take a backup
of your current Integra.ntf file before downloading, possibly renaming it
to distinguish it from previous versions.

3 Run the Integra Set-Up Program

The Integra.exe file is an installer which contains the Integra.ntf template file as well as the user documentation.
There are no other executables or DLL’s in this installer.

Having received Integra.exe in your e-mail or downloaded it from the download page provided, you should have
detached the file to a directory of your choice. This is a working directory from which you will then be able to
remove Integra.exe after its successful install.

Integra for Motes 4.5

Exit Lotus Notes before running the Integra set up. Run the
Integra.exe file by double clicking on the file in Windows
Explorer having identified the folder in which you stored it.

.
\‘!) Please close Lotus Motes applications before proceeding with this installation.

On running Integra.exe, you will see a small splash
screen. In the event that Lotus Notes was still running,
you will be warned to exit through a dialog box.

Tntegen for Nates 4.5 — el Sl - e e ==

The Integra Installer Wizard will then be presented to

integra |
the user as shown alongside: e

Wulcome lo the nslallsbon wizad ol Inlegia lor Holes and Intemas Uuich. Heporls

et b Mol orad Indigan usch, Fegmets ondo s

PIF suppart
Label wizard

Farmuda Builder
Lockup Wizard
Serip Husdchen
In-Place Editing
and much mone

Integra for Notes 4.7 — Upgrade Manual Version 1.01 4
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On selecting the Next option, the user will be shown the software license agreement and given the opportunity to
agree or disagree with the terms of the agreement. The Accept option can only be used once you have scrolled
through the license agreement.

Integra for Notes 4.5

TWH by by e e st o e apmernerd

Soltwante Liconsa Agraernart
edngen ot Mot & Irtagrs Quick legarts

Thit & B it of o <
Iederea bor Moles, Inkoges Ghach, Freports, Iekoges POF Wiker and any uprpardes Berct
» ) e Lid

By

. ar il ous agr

o o d hic K S——

immeciately. By not doing 10. you e expbcily scceping theie condbion:.
Evalusiors #you Scitware Prcdhacts, then

Disagreeing with the terms will result in the exiting from the install process while agreeing will proceed to the next
stage.

Assuming the user proceeds, the dialog to select the directories will be presented to the user.

Remember to backup your previous Integra template before proceeding

Tntegra for Notes A5 ap— ===

Two sets of files or links will be installed during this process:

The Integra.ntf template - as with all Notes templates, this
file is required to be stored in the Notes default data
directory. The Installer reads your registry settings to
determine the default Notes data directory of your local
installation and this is displayed in the dialog box. The
option to change this exists using the Browse. IT IS
IMPORTANT THAT THE INTEGRA TEMPLATE IS STORED
LOCALLY AND NOT ON THE SERVER.

The documentation files — links to the user manuals
available on the Integra web site.

The Integra Installer will provide the user with a choice of locations where to deploy the files contained in the
installer. The default for the template is the Notes default data directory while the links to the documentation
defaults to c:\Program Files\Integra for Notes 4. The directory for the documentation links can be modified by the
user selecting the Browse button.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 5
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By proceeding further the user can then select the Program Group that the documentation files will be created in.
This allows selection of the files from the Windows Start->Program Files menu. The default Group name is Integra
for Notes 4.7. The current list of the user’s groups are displayed.

Integra for Notes 45

Select Program Folder

Ointegra
fomnotes )

Administrative Tools

PDF support

Label wizard

Formula Builder

Lookup Wizard

‘5"‘”‘5“"",?’ Softwars General
n-Place Editing Startup

and much more tites

InstallShidld «Back Mest> Cancel

Having selected the group the user is given one final opportunity to confirm:

Integra fr Notes 45 [=%=)

©integra

Cusert Seltrazs

"t c
Initalation S-cope 0 Usets

Files 10 b Instalied:
et s Nides T gt [Indegr s rll)

PIF supparnt
Label wezase]
Forrmula Bukder
Lockup Wizard
Soript Budder
Inv-Place Editing
and mauch mone

- - — =
Install5 < fack bsd 3 Cancal

On confirmation the user will see a number of progress bars while the files are copied to the chosen directories
following which a conclusion screen is presented.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 6
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Sign the Template

So as to ensure the smooth operation of Integra for Notes within your environment, we strongly
recommend that you sign the Integra template using an appropriate ID used within your organization for signing
3rd party applications and which is granted rights in users’ ECL’s. Should you intend using the scheduled facilities
of Integra, then the ID should also be authorized to execute restricted agents on the server on which Integra is
deployed.

Refresh Design

As with any Notes database, a user with a minimum of Design Database - mm 7 ¥
level access to a database is able to refresh or replace the S i | S | ] 2] a | =
design of a Notes database from the template that it is
connected to. The relationship between a database and its
template is defined within the Design tab of the Database’s
properties box.

Design is not hidden

Options
Allow design locking
v Lt in Database Catalog

To upgrade your current version of Integra to the 4.7 version, set v Z:t:ic:ze-;pen Database’ dialog

the Design Template on which your existing Integra database is Includs in multi-database indexing

to inherit its design from within the Design tab of the database Do not mark modified documents as unread
properties of the Integra database (see screenshot). The design Mark parent note on reply or forward
template for Integra for Notes 4.7 should be set to: Inhertance

¥ Inherit design from master template
IntegradNotesR47 Template name  IntegradNotesR47

Once this is done, the Integra database is able to be updated ~
through the usual manual process of refreshing the design of a Cmbeimmbalpsigaanedsdie sopffmnemmans. L
database from its parent template. In Notes 8 this is undertaken

using the File\Application\Refresh Design menu option while in earlier versions of Notes use the file menu

File ?Database PRefresh Design. This option will allow the user to select the current Integra database (either on
the server or local) and then run the refresh from the user’s local workstation to which the Integra template had
been deployed.

Refresh Database Design of Work\SSL Integ [ |

With dezign from Server

It is important that the Integra for Notes 4.7 template is placed on the local workstation of the user undertaking
the upgrade.

For a database’s design to be refreshed, the current user must have a
minimum of Designer level of access to the access control list of the database.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 7
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6 Upgrade Documents & Profiles

The new Integra template contains updates to messages and the on-line help. In addition Integra for
Notes ships with a number of sample profiles which can be used immediately to provide value to your organization
as well as the allow you to dissect the profiles as a means of better understanding Integra for Notes. New versions
of Integra may contain improvements to standard profiles shipped with the product. The Upgrade Documents &
Profiles agent automatically upgrades the existing profiles as well as adding any new profiles and updating
messages and help.

il All Profiles - IBM Lotus Notes

The Upgrade Documents & PrOfileS Fie Edit view Creste Actions Tools window Help
age nt iS run th ro Ugh the ACtiOn Adrninistration »  Integra Maintenance

‘“workskation Options » Inteqgra Update - Web-Download Request
menu. et Logging OnfOFf (WEE & SCHEDULED PROFILES)

Mew Profile
Upgrade Documents & Prafiles

Settings. .. weh Activity

@ ¢ G m Tools, ..

Categarize...

T~

LA

L
)

e —— \"-M-#-_-r

\.J Only run the Upgrade Documents & Profiles agent after having undertaken
1‘1' the Refresh Design process.

On running this option, the user will be given the opportunity to choose the parameters to be updated:

,..
L

Upgrade Documnents 8. Profiles - Options

integra
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Select Update Options:

¥ Standard Master Templates
¥ System Messages

In the event that the standard profiles that shipped with Integra had been modified by a user, the modified
standard profiles will not be updated by this agent. Should you wish to update a modified standard profile, delete
the modified profile manually and re-run the Upgrade Documents & Profiles agent.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 8
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7 Re-enable Scheduled Profiles

In some situations, Lotus Notes may disable any scheduled agents running on a database when that database’s
design is refreshed. Although such an occurrence is rare, if you utilize scheduled profiles on a Windows based
Domino server, it is prudent to re-enable the agent set in Integra which controls the running of profiles which are
scheduled.

Scheduled profiles in Integra can only be executed on a Domino server

d running on a Microsoft Windows™ environment or a Lotus Notes client also
running on Windows. If the operating system you use is not Windows, DO
NOT ENABLE Scheduled profiles.

i Comfiguiation - [RM Ltut Notes
Fie [t Veew Creste Acions Tet Tock Window Help

To re-enable scheduled profiles, select the Configuration view | @3 <& Ba-088 &1 8
in the Integra navigator. This view is only accessible to users ~ |* irters _
that have been granted access to the [Admin] role. On K 0. e [# ConﬁguratiO_f
selecting this view, the user will be presented with the ° e g s e | smasors | #0 | e o~
Configuration document which contains the Scheduling tab. 5 e Enabling or Disabling Scheduled Profiles
. | Schecied potiss are axecsted by an houty scheduled agant Once is agect
SeleCt th|$ tab '"J' m ;:m:a s 18 un rnrmee}’ur-ermnnmﬂ'n; alths nn.snm.:;'p-nuu agent &
4‘: nids b b mggened on e serer }
. . . o [/] I'o Lnable Scheduled Prohles Click Here
Select the Enable Scheduled Profiles hot spot in this o & &
. . A
document to trigger the enablement of this agent. @ Ve
=]

il )IJ_‘,,___"_..‘ AP S—— _'4,

8 Replace License Key — only for upgraders from version 4.2 or older

User of Integra for Notes version 4.2 or older will at this point have to replace the current license key found in the
License tab found in the Configuration page with the new Integra for Notes license key.

9 Enable Database for Web

=@ =

If your Integra database is deployed for usage by web

browser users, then you will need to enable the BN

Integra database for Web usage. This is done through dFss|aspsn-090 5 19 - :
the Web tab of the Configuration document. In = . X

o ; . : Omtegra (7 | Configurati -
addition, the actual profiles run via a web browser = R ¢%|Configuration (g

also need to be enabled for the web (see the Integra
for Notes Designer’s Manual.

Licansa | Logging | Scheculing | Web | Searticans | PO | Mare Opbans | o '

b Wb Contguraton

Word Profiles

DRy eed Snon @l

Flalstve Damina servist path  [aarylel 1 |
Serviet URL R JfeVerest ACme com/sarviel

The two fields on this configuration page store
configuration settings used by the web aspect. The
field contents are to be as follows:

s Akt for Explorer © Yes W N

afibes

@ lolnable Thes inlegra Databraso F.or Web Browscrs. Click Hore

3 ToDizable This Integrs Database For Web Biowsers Chck Here

e 8

Relative Domino Servlet path — this field e
identifies the directory under your default = - - = p——
Domino data directory which contains servlets. It

is by default called /servlet but in case your organization uses a different folder to contain servlets, this should
be reflected here.

Integra for Notes 4.7 — Upgrade Manual Version 1.01 9
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Servlet url — this field defines the complete url that points to the servlet directory. This is likely to be
something like http://everst.acme.com/servlet or http://www.acme.com/servlet.

Use Active-X in Explorer — this option allows Integra to be set to allow Active-X to be used by users of
Microsoft Internet Explorer.

9 Due to the security settings of the Domino environment, it is important that when these
i agents are enabled, they are enabled using a Notes ID with sufficient access rights to run
“ agents on the server and the appropriate ECL settings for accessing the file system.

In addition, since one of the agents deletes documents in the Integra database, the ID must
also have deletion rights in the ACL of the Integra database.

10 Enable Integra PDF Writer

While previous versions of Integra have supported various 3™ party solutions for the generation of PDF files,
Integra for Notes 4.5 onwards now supports its own Integra PDF Writer which is licensed for your use across all
Integra licensed users. The Integra PDF Writer is a printer-driver based PDF writer and requires the deployment
and installation of the writer to the desktop. This can be effected directly through Integra (see section

The installation of the Integra PDF Writer requires three steps:

1. selection of the Integra PDF Writer as one of the required PDF options in the Configuration page.

2. attachment of the Integra PDF Writer executable software into the Configuration page. This enables easier
distribution of the executable to end-users, particularly ones that might be on remote networks or laptop
users.

3. running of the Integra PDF Writer installation routine by end users on their workstations.

This installation will require a reboot of the PC.

10.1 Configure PDF Output

The PDF writing capability needs to be configured by the administrator inside the Integra database itself before it
can be used. This is done through the Configuration page where a tab is specifically dedicated to the PDF

configuration. WSS it rii P L  — A LA
W_

The configuration requires that you first select the Integra _ ‘”

PDF Writer as one of the PDF options in the Configuration . @integra o E——

page. o

Following this, the installation requires that the Integra PDF
Writer installer is executed on each workstation that is to use
this capability.

ot 1 S Tty | ot 995 (ot | Ao Aot () | b Wt Fsichn (v

Inbogra PDF Wriler Seftings.

CECADEdS S S wRNEOR

This can be achieved in one of 2 ways:

Distributing the Integra PDF Writer installer to all users
by means of deploying it to a file server and pointing
people to it and allowing them to install the installer

Integra for Notes 4.7 — Upgrade Manual Version 1.01 10
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Attaching the installer EXE into the PDF tab of the Configuration document found in the Integra database as a
means of distributing the installer and using the installation command in-built into Integra (see section 10. 2)

This facility ensures that no separate distribution of
the Integra PDF Writer software needs to be made

to end users.

You can obtain the Integra PDF Writer software in either

of 2 ways:

point your browser at

www.integradnotes.com/integrapdf

e

@ !rteora

or open the Configuration page of the Integra
database (you will require access to the Admin role
in the database’s ACL, and move into the PDF tab.
Then click on the Integra PDF Writer

Downloadbutton.

Integra POF Yriter Download

CLapErSS S uBEOOESS

Licensa | Loggeg | Scheduieg | Web | Smatcens

maomated comnion

¥4 ietngen POF Witer inatuler hanss

| 2 Configuration

PO | Mare Opsons

POF Support

Wioid tacuments 1 POF oamal ising Ba Jofowesy

Chard | Sowane 196 (Chant) | Adobe Acssbat (Chent) | Shaved Wach Fokte Sarew)

Intagra PO Wiiter Saltings

ek hoig IR PET TN O |

i oo e rLatatoe of biagrd POF Woet o6

"]

Either of these options will take you to the appropriate page on the Integra web site which contains this
executable and allows you to download it to a temporary folder of your choice.

To download the Integra PDF software:

1. Rightclick on the 0 e o e s e i e ——— )
. . |U|e Edit Yiew Higtory fockmarks looks Help
IntegraPDFWriter.exe icon at L) P T - B -G »
the bottom of the page. O lncograPOF Wrerluctsber
2. Select the Save Target As... .5?.‘?9‘5"‘, \%
option. You will be prompted )
to save the file to a directory of j—
your choice. Save the -
IntegraPDFWriter.exe file in any
temporary directory on your
. Integra PDF Writer Installer . |
workstation. )
This page contains the inskaller for the Integra POF Wiiker.
Instructions for downloading the installer
1. Raght chck on the IntegraPDF Winter.axe icon below.
Once the download has been 2. Selnct tho Save Terget As... ption.
effected, open the Configuration v e e vy ey Bracy ey i
document inside your Integra T e S L e N b cven e 10
database, open the PDF tab and e For (cienc tab
. . & ii UHLU G 5. To nstall the [nr:ffa FOF Writer, nun Actions -> Workstation Opoons -> Instal
attach the Integra PDerterF.exe f”e Ul Integra POF Wriber from inside the Integra database. .
into the Rich Text field in the e rocommand you conzult th.Integra Instalaton & Confguration Hanual nd the :
Integra PDF (Client) tab. e e
| Demne
Once this is done, the installation
on workstations can proceed (see section 10.2 below).
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10.2 Installing the Integra PDF Writer on the Workstation

Once the Integra PDF Writer software has been il Integra for Notes - (Excel Profilesiby Category) - IBM Lotus Notes
attached into the Configuration page, end-users  |Fle Edt Yiew Create Actions Tooks Window Help

will be able to install the software on their o Administration ¢ '_—
‘Workstation Options 3 Install Integra SmartIcon

ﬁ Haome

workstations. To install the Integra PDF Writer oo Prefie Tnstall Iniegra PDF Writer

H i Preferences
on the WorkStatl(,)nl open the lnte,gra dat.abase @ @ G B ?:totl?gs Repair { Upgrade Profile Selection Folder (é
and then run Actions -> Workstation Options -> A 7| SetTo Active Integra Database
Install Integra PDF Writer from the main Lotus - v'."'. SR — Y
Notes menu.

You will be presented with a page with an Install and an Uninstall button. Install Uninstall |

Select Install and follow the installation wizard. This installation will require a
reboot of the PC.

In the event that the user attempts to install the Integra PDF Writer without the administrator first having attached
the Integra PDF Writer installation EXE in the Integra database, the user will be provided with a warning message.

|

The Integra POF Writer Installer could not be found in the Integra Configuration document
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Support

Should you have any difficulties effecting the upgrade to Integra for Notes, please send an e-mail to

integra

for notes

support@integradnotes.com providing as many details about your configuration and setup as possible including:

e Your current version of Integra for Notes and the version you are upgrading to

e Your operating system version of your workstation and client

e  Your version of Word, Excel

e Inthe case of a PDF related support issue, the PDF generation product you are utilizing and the version

number.

Contact Details:

Tel USA:  (508) 915 4805
(650) 276 0506
Tel UK: (020) 7193 1296
Tel Europe: (+356) 2131 9977
Fax: (+356) 2131 9528
Skype: integradnotes

Shireburn Software Ltd
Carolina Court

Guze Cali Street

Ta' Xbiex MSD 14
MALTA

support@integra4notes.com
www.integra4notes.com
www.integrareports.com

Useful web links:

www.integra4dnotes.com
www.integra4notes.com/demo
www.integra4notes.com/faq
www.integrad4notes.com//manuals
www.integradnotes.com/support

integra

for notes

support@integradnotes.com
www.integradnotes.com

Tel USA: (508) 915 4805 or (650) 276 0506
Tel UK: (020) 7193 1296
Tel Europe: +356 2131 9977
Fax +356 2131 9528

Time Zone CET (Paris, Berlin, Rome)
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